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Making an ebook with Blurb for the first time?
If this is your first time reading this guide, go straight to the Getting Started section. 

I’ve already created an ebook, now what?
Review your ebook
Your ebook needs to be thoroughly proofed on a device so you can see if there’s anything that needs 
to changed or improved. Jump to “Download and Review” section.

Get expert help
If something doesn’t look the way you expected, and you want to figure out what to change in 
BookWright to get a desired effect, we have plenty of resources to help:

•	 If the structure or order of your chapters is off, take a look at the Book Structure and 
Organization section of this guide.

•	 For layout and text questions, review the Content Layout and Text Styling and Images 
section of this guide.

•	 For a quick start on common tasks, watch some of our helpful videos on using BookWright.
•	 Want to hire a publishing expert? Speak with a pro from our Dream Team.
•	 Read our FAQ. Someone has probably asked a similar question to yours.
•	 Still stuck? Contact our 24/7 customer support team – blurb.com/help

Make changes, repeat
Editing in BookWright is a snap. Once you’ve made your changes, just re-upload the same 
BookWright file for conversion. You can download the revised ebook to check your changes. Repeat 
this editing process until you’re happy with the results.

Distribute and sell your content
Here’s more information on how to create accounts with the iBooks Store and the Amazon Kindle 
Store to sell your reflowable ebook.

http://www.blurb.com/dreamteam/collaborators
https://support.blurb.com/entries/60413840
http://www.blurb.com/help
https://www.apple.com/itunes/working-itunes/sell-content/books
https://kdp.amazon.com/ 
https://kdp.amazon.com/ 
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Getting started

Welcome
This guide is here to help you make a fantastic reflowable ebook for the Apple iPad, Amazon Kindle, 
or other e-reading devices. All topics discussed here are about reflowable ebooks only. If you want 
to create a fixed-layout ebook, simply design your book in BookWright and upload it—no guide 
necessary! 

Great expectations
You’re about to start creating your ebook in BookWright, Blurb’s powerful layout and editing tool. 
By bringing your content into BookWright you can easily position and resize images, format and 
style text, create linked table of contents, and then output into an ebook. This guide will help you 
understand how what you see in BookWright will be transformed into a similar but streamlined 
ebook optimized for reading devices and apps. BookWright’s edit window shows fixed pages, 
whereas reflowable ebooks have a fluid, “pageless” layout. That is to say that the pagination—and, 
to some extent, the layout of reflowable ebook content—varies depending on the size of the reading 
device’s display. 

Reading devices can be large or small (like a tablet versus a phone screen) and the amount of 
content that fits on each screen is different. Your readers may also choose to change the text size, 
margins, background color, or even the font. So instead of editing page-by-page in BookWright, 
you’re actually working with one long piece of content that will be broken up into pages by the 
e-reader device and the reader’s preferences. You can indicate your own font preference as the 
author, but ultimately the viewing experience depends on the reader. It’s this flexibility in formatting 
that makes reflowable ebooks so accessible, versatile and readable across so many different 
devices. 

If you want to maintain control over the exact placement of images, column layout, font selection, 
and styles, a fixed-layout ebook might be the better option for you. But don’t worry, we’ll show you 
how to structure your content to get great results, so let’s get started!
Store to sell your reflowable ebook.
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Get the latest version of BookWright
Before you begin, you’ll need to have the latest version of BookWright installed on your computer.

1.	 Download BookWright. If you already have BookWright installed, it will automatically update 
to the latest version the next time you launch it.

2.	 Take a look at the BookWright Guide. Once BookWright is installed on your computer we 
highly recommend spending a few moments familiarizing yourself with the application.

Tip: In particular, pay attention to the image, flowing text and RTF import sections. We’ll be discussing these 
concepts in more detail later on. 
3.	 Also check out some amazing BookWright novel templates to help give your novel a 

professional look from the start.

Workflow overview
Let’s take a moment to describe the steps you’ll take to create your ebook from start to finish. We’ll 
go into more detail later for each of these steps.

1.	 Save your original document as an RTF (Rich Text Format) file. Edit your content in Microsoft® 
Word or a similar text editor. We recommend using Word because its RTF output is most 
compatible with BookWright’s RTF importer.

2.	 Create a new BookWright Project and import the RTF file(s).
3.	 Create chapters, add styles, lay out your content, and add images, and create a cover.
4.	 Upload your book project to convert it into a ebook.
5.	 Download your new ebook and review it on a reading device or app.
6.	 Make any changes in BookWright and repeat steps 2-4 until you’re happy with the final result.
7.	 Distribute and sell your content on the iBooks Store or the Amazon Kindle Store.

Let’s look at these steps in more detail…

http://www.blurb.com/my/account/register?jumpto=/bookwright%3Fdownload%3Dtrue
http://www.blurb.com/my/account/register?jumpto=/bookwright%3Fdownload%3Dtrue
http://www.blurb.com/guides/bookwright/adding-photos
http://www.blurb.com/guides/bookwright/flowing-text-containers
http://www.blurb.com/guides/bookwright/importing-rtf-documents
http://www.blurb.com/sites/default/files/bookwright_templates/FlourishTemplatesGuide.pdf


12/03/2014

BookWright Reflowable Ebook Guide

Create and edit your source content
The best place to write and edit your text-heavy content is in your favorite word processing 
application, like Microsoft Word. You can create your content in any editor, so long as it exports 
RTF files, but our converter is optimized for Word and will yield the most predictable results. Other 
editors include Google Docs, TextEdit or Open Office. 

What to do before exporting an RTF file:
•	 Spell check and copyedit your content.
•	 Style any text with bold, italics, underline, line spacing, etc.
•	 Insert Section Breaks (Odd Page) to separate chapters. ‘Next’ and ‘Continuous’ breaks are 

ignored.
Tip: In Word, use the Insert > Break > Section Break (Odd Page) menu option.
Tip: Alternatively, you can save each chapter as a separate RTF file instead of using section breaks. A 
chapter will be added for each RTF file you insert in BookWright.
•	 Add in any front matter to your book, such as a copyright page, or a Table of Contents. Insert 

a Section Break (Odd Page) between each piece of front matter.
•	 Use tabs for paragraph indentation.
•	 Avoid hanging indents in Word and prefer using the indent tool in BookWright.
•	 Download the novel templates for BookWright here.
•	 For best results, use whole numbers for your line spacing or leading values.
Tip: Check out our Dream Team for access to professional editors who can help review your content.

What formatting is NOT supported in the RTF import:
•	 Drop caps (they change to normal font and size)
•	 Embedded images, tables, charts, shapes, headers, and footers (they will be ignored)
Tip: Add images after you import your RTF file to BookWright. Tables and charts can be saved and inserted 
later as images.
•	 Word Styles (any text styles need to be applied inline, not through the Styles menu)
•	 Page backgrounds
•	 Multi-column layouts
•	 Links between pages or sections in your Word document
Tip: if you want to create a linked Table of Contents, do that in BookWright. The imported links from Word 
may not be accurate.
•	 Bulleted Lists: create lists by adding • symbols or numbers manually with your keyboard

http://www.blurb.com/sites/default/files/bookwright_templates/FlourishTemplatesGuide.pdf
http://www.blurb.com/dreamteam/collaborators
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Save your document as a 
Rich Text Format (RTF) file.
The option to export to RTF is usually 
found under File > Save As… 
in the menu bar of your text editor.

Importing your RTF file(s) to BookWright
Once your content has been saved as an RTF file you’re ready to import it into BookWright.

First, let’s create a new project in BookWright. 
Tip: Click the Start a New Book button

For reflowable ebooks we recommend choosing 
the 6x9 Trade Book project option on the 
“Choose a Book” screen.

Why do you need to pick a paper size when reflowable ebooks don’t have a fixed page size? 
Remember that in BookWright, you can design a print version at the same time you’re creating an 
ebook. By selecting a print size now, you’ll have everything ready to go if you decide to publish a 
print version of your book later.

Now let’s get your files into BookWright. You may have saved your content as a single RTF file or as 
separate RTF files, one per chapter. Either way is fine.

Import your RTF file(s)
1. Open Blurb BookWright
2. Click on the ‘Text Files’ icon            in the top toolbar.
3. Click on the ‘Add RTF Files’ icon
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Browse to and select your RTF files
4. Browse your computer and find the RTF files to import
5. Select the files (hold down the Shift key to select multiple files) and click Open

Add the RTF file(s) to your book
Your files are in BookWright but still need to be placed into the pages of your book.

6. Your imported RTF files are listed in the Text Files library in BookWright
7. Drag the RTF file(s) onto a blank page
8. Choose the desired layout for the page and click ‘Apply Layout’

Tip: The different layout options and margins only apply to the print version of a book. Your selection will not 
affect your ebook.

9. Repeat the steps above to drag in more RTF files. 
You’ll want to drag each RTF file onto the blank page following the Text Flow of the last imported 
RTF file’s content.

Tip: Here’s a video showing how to use the RTF Importer.

https://www.youtube.com/watch?v=b68TIIVRYBE&feature=youtu.be&list=PLPeS5XD2B_Yxpu6-ZgxpFDVgyNDPR51JQ
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Text Flows and Text Containers
After importing your RTF files, you’ll see that the text has been inserted into your book, and 
BookWright has added as many pages as necessary to fit your text. Each RTF file is inserted into a 
Text Flow. A Text Flow is made up of linked Flowing Text Containers. Each page has a linked Flowing 
Text Container, and your text “flows” from one container to the next. Flowing Text Containers are 
different from individual Text Containers in that they are “linked” together in a sequence. This means 
that if you change the text, resize the container, or reformat it, the text will “reflow,” refilling the 
other containers as needed. 

Tip: If you find there are empty pages or containers at the end of your book after you’ve done all your editing 
and layout work, you can safely delete them. 

Tip: Identify Flowing Text Containers by the numbers in top left corner when you hover over them with your 
cursor.

Flowing Text Container

Regular Text Container
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Using the RTF importer is the best way to import large amounts of text into BookWright. Each 
imported RTF file is placed in a new Text Flow. When we create the ebook, we automatically place 
each Text Flow into a new chapter in the ebook. 
You can manually create Text Flows if you want to copy and paste more content later but using the 
RTF importer is preferred. Here’s how to manually create Text Flows.

Tip: If you make a Flowing Text Container smaller, by adjusting its height, some of the text may run beyond the 
end of the Text Flow and no longer be visible in the book. To fix this, go to the last container in the Text Flow, 
click the Link button, and draw another Flowing Text Container to hold the overflow.

Tip: Don’t use more than one Text Flow sequence on the same page.
Tip: For more information on working with Text Flows in BookWright, watch this video.

Text Containers (not part of a Text Flow) should be used sparingly. When placed directly below an 
image they are considered captions and the width of the text will match the image’s width in the 
ebook.

Tip: If you place a text container between two linked Flowing Text Containers a new line will be inserted before 
and after the text container’s content.

For more information on working with Text Flows in BookWright watch this video.

http://www.blurb.com/guides/bookwright/flowing-text-containers
https://www.youtube.com/watch?v=dX38hHU1T34
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Fonts
Blurb offers 53 beautiful fonts licensed specifically for use in your ebooks. After importing your RTF file 
you’ll need to replace the fonts used in your text editor with ebook friendly fonts listed in BookWright. 
You can find them at the top of the fonts dropdown menu. Make sure you use only these 53 fonts in your 
ebook, otherwise the e-reader will use a default font.

Tip: To change a font, select the content in the text editing window and choose an ebook friendly font from the 
dropdown list.

Tip: For more information on working with Fonts in BookWright watch this video. 

BookWright tips
•	 Never overlap text or image containers, or layer text over images.

Tip: If you want text superimposed on an image, use an image editor like Photoshop to make the text 
part of the image.

•	 Background elements, such as page numbers, headers and footers, and background page color will 
not be included with your ebook.

•	 Pay close attention to any warning icons             while editing.
Tip: Sometimes help and warning messages in BookWright only apply to print but not ebook versions of your 
project.

•	 Review any messages and suggestions during the upload process.
•	 Move image containers not the image inside a container. This causes images to be cropped.

Tip: to move an image on screen, click and drag it by selecting the border, instead of clicking on the image itself.

•	 When adding a new image to your book, just drag and drop it onto the page.
(Rather than creating an empty image container then inserting the image into that container.)

•	 When resizing images, drag the border’s corner handles, while pressing the shift key. Then click on 
the image and press the “Fill” button          in the image toolbar. This will preserve the aspect ratio of 
the image without cropping.

•	 Be sure to only use the BookWright novel templates which are optimized for reflowable ebooks. All 
other templates are meant for print and fixed-layout ebooks only.

•	 For more BookWright tips check out the BookWright Guide or talk to someone on our Dream Team.

https://www.youtube.com/watch?v=1krea9fTVg4
http://www.blurb.com/sites/default/files/bookwright_templates/FlourishTemplatesGuide.pdf
http://www.blurb.com/guides/bookwright-how-to
http://www.blurb.com/dreamteam/collaborators
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Book structure and organization
One of the keys to creating a readable and successful ebook is organizing it into sections or 
chapters. You’ve already structured your content in Word, thinking about what’s in your front matter, 
content and back matter. This section will describe how to format your content in BookWright to 
utilize an e-reader’s table of contents, separate sections or chapters with breaks, and create links 
between different parts of your book.

E-reader Table of Contents
Ebook reader apps make it easy for consumers to quickly find and move between content by 
providing a table of contents separate from the book content. In ebooks this information is saved in 
a special file. Blurb creates this file for you automatically based on how you structure your content in 
BookWright. It’s a really good idea to have more than one chapter in your book, even if a chapter is 
only one “page” of content.

A chapter is created...
•	 For each Text Flow
•	 For each section break (odd or even page) from your source RTF file
•	 For every RTF file you import and drop in the editor

Chapter titles
We automatically create the titles for each chapter in your table of contents by looking for the first 
sentence with the biggest font size in a Text Flow. 
Tip: For best results put your chapter title first with the biggest font and avoid using numerals with periods in 
the title.

iPad table of contents screen
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Page breaks
In general e-reader apps do a good job of breaking content into pages when a person reads your 
ebook. Remember that the visual end-of-pages in BookWright do not translate to page breaks in 
your ebook. However, it’s still possible to start content on a new “page” in the ebook by using these 
strategies.

•	 Insert page breaks in Word before saving and importing your RTF file.
Tip: from the Word menu choose: Insert > Break > Page Break
•	 Add newlines or press the Enter key multiple times after the text content in the end of a 

Flowing Text Container to push text to the next page.
Tip: Don’t worry, the extra newlines won’t show up in your ebook
•	 Place a single image on a BookWright page before any Text Flows
•	 Start a new Text Flow (this also creates a new chapter)
•	 Resize a Flowing Text Container (this moves text to the next page)

Tip: Whenever you resize a Flowing Text Container be sure content isn’t cut off at the end of the Text Flow 

Creating a Table of Contents in front matter
If you want to make your own Table of Contents page in the front matter, do so by using the 
Hyperlink tool, linking to the appropriate pages in BookWright. Even though the page numbers won’t 
matter in the ebook, clicking the links will still send the reader to the correct spot in your ebook.

Tip: If you make your own linked-text Table of Contents try to keep the formatting simple. Avoid using dotted 
lines (“............”) as the layout will not be consistent. Also avoid listing the print page numbers as they won’t match 
the page “numbers” in the ebook.
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Content layout

The content you lovingly craft needs to be transformed from a static page-by-page view in 
BookWright into a flowing, dynamically laid out ebook. This section will walk you through the process 
so that you can get predictable, beautiful results in your ebook.

Mapping BookWright containers to an ebook
In general ebooks look their best on e-reader apps when the layout is simple and stacked vertically. 
The conversion from what you see in BookWright to an ebook tries to stack your content, single file, 
vertically. 

We call this the “More than one, stack it” rule. 

That means if you position page elements side-by-side (images or text), they will be stacked 
vertically according to their reading order (left-to-right, top-to-bottom).

In the following example we have two images (with captions) side by side in BookWright.

Those two images (and their captions) will be stacked in the ebook. View of the same content in the ebook on a tablet and phone.
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In the following example we have an image with caption and text side by side. Because there is more 
than one container they will be stacked in the ebook.

View of the same content in the ebook on a tablet and phone.
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Wrapping text around images
There is one exception to the “More than one, stack it” rule. If you position text to the right or left of 
an image (with no caption) we’ll wrap text around that image in the ebook. In this manner you can 
use Text Flows to elegantly wrap text around images.

In the following example we have an image, without a caption, with text to the right and below it. The 
text content will wrap around the right of the image in the ebook.

Text to the right of an image in BookWright View of wrapped text in the ebook
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Text Styling and Images

Much of the styling that you can apply to text content in BookWright passes directly through to your 
ebook. Here are some tips on what styling works best. 

Text alignment, justification and indentation
BookWright’s text editor supports left, right and center justification. Most alignment will 
automatically pass-through during the RTF import. 

•	 Avoid using spaces for indentation, instead use the indent tool                in the text 
editing toolbar, or the Tab key.

•	 Avoid using hanging indents in Word                before importing your RTF file.
•	 Use center justification          rather than using the space key to center content.
•	 Avoid using fully justified text. Although standard for print books, this sometimes 

leads to widely spaced words in the last sentence on a page in ebooks.
•	 Paragraphs are not automatically indented. If you would like to indent the first, or 

every paragraph in your ebook, use the Tab key on each paragraph to indent the 
content.

Fonts and special characters
Blurb and BookWright provide you with a wide variety of fonts (53 to be exact!) licensed for use in 
your ebook. In addition, our Flourish Font contains beautiful glyphs to add inline ornaments to your 
chapter titles that scale with the size of the text in e-readers.

•	 Use black, or dark font colors. Light colors may be hard to see because by default 
most e-reader backgrounds are white. 

•	 Use our Flourish Font glyphs instead of images for chapter title pages. For more 
information on the Flourish Fonts click here.

•	 Custom embedded fonts are not supported. Only the “ebook friendly” fonts listed in 
BookWright may appear in your final ebook.

Line spacing
In general it’s best to keep your line spacing or leading in whole numbers. Avoid 1.5 spacing, for 
example.

Web links (hyperlinks)
BookWright and its generated ebooks support internal links (from one page of a book to another) 
and external links (any page on the internet). 
•	 Always double-check all links in your book before publishing your ebook. 

Tip: Internal links from your Word document won’t work in BookWright. External links may have some 
formatting issues. Click all your links to be sure they work as expected.

•	 Avoid inserting URLs with long query strings (text following a question mark in the URL)

http://www.blurb.com/sites/default/files/bookwright_templates/FlourishTemplatesGuide.pdf
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Bulleted lists
Create lists by adding • symbols or numbers with your keyboard

Background content
Content elements in the Background tray,                  such as page numbers, headers and footers, and 
background colors are ignored in the ebook.

Designing for print and ebook simultaneously
BookWright does an amazing job at balancing the needs of creating an ebook and a print book at 
the same time. But sometimes there are specific layout adjustments you may wish to make for one 
version but not the other. 

In these situations a viable solution is to: 
1. Finish laying out your print or ebook version
2. Browse to where you saved the .blurb file for the book
3. Duplicate that .blurb file, and give it a unique filename
4. Open the new file in BookWright
5. Make the print or ebook specific modifications to the separate file.
Tip: If you follow the above strategy there will be unique entries on your Blurb dashboard for each of 
these books.

How to add images to your book
Because images aren’t imported along with your RTF content, you’ll need to add them in as a 
separate step. Here are tips how to size and position images, and how to maintain their quality when 
adding images to BookWright.

First, move or resize any Flowing Text Containers to make space for an image. Then drag and drop 
image directly into the empty space.

Tip: Images for ebook use should be 500 KB or smaller, no more than 300 DPI, and be in sRGB color.
Tip: Resizing containers might cause text to overflow; if so, you’ll need to add and link more flowing text 
containers at the end of the text flow.

Tip: For more information on working with images in BookWright watch this video.

Resize to make space
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Adding captions to images
Adding captions to images are the one time you should use simple Text Containers instead of Text 
Flows.

1. To draw a new text container, click the Draw Text Container button under the Layouts section 
in the toolbar.

2. Drag the pointer to draw the text container below the image. 
3. Move the Text Container up so that its top edge snaps snugly to the bottom edge of the 
image. 

Tip: Don’t overlap the text container and the image.

Image Best Practices
Here are some tips when working with images.
•	 JPEG and PNGs are the only image file types accepted
•	 Avoid using transparent PNGs. Amazon Kindle devices do not support them.
•	 Try to keep your image file sizes under 500 KB each and no more than 300 DPI.
•	 Never overlay a text container on top of an image. Instead add the text in an image editor like 

Photoshop.
•	 Use sRGB image colorspace and not CMYK.
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Image Spreads
While you can place a single image across both pages in BookWright, because there are no spreads 
in reflowable ebooks the image will be shrunk to fit on a single “page” in the ebook. Only add one 
spread image per two pages in BookWright.

Tip: Be careful that non-spread images don’t overlap the spine, or middle area, between the left and right pages 
in BookWright. 

Image processing
Ebook’s don’t require as high resolution as print books to look great on e-reader screens. Our ebook 
conversion always tries to preserve your original image. However under certain circumstances the 
image may need to be processed and saved as a new image. You can avoid image processing by 
matching the image container’s aspect ratio (width and height) with the image’s.

Tip: Even though the image may look small in BookWright, the full-sized image is saved in the ebook. Double-
tapping the image in most e-readers will show the image closer to full size.

Conditions that trigger image processing:
Cropping and rotating images within an image container. If the source image inside of an image 
container is bigger than the container, the image will be cropped.

•	 Photographs containing EXIF information. 
•	 EXIF information can specify the orientation of the image, ex. images taken from your camera 

phone in landscape or portrait. To make sure the image has the proper orientation we strip EXIF 
information and resave the image in the correct orientation.

•	 Unsupported colorspaces. If the image is saved in CMYK (used for print) or other unknown 
colorspaces we will convert it to sRGB and resave.

•	 File size is too large. We want your ebook to work on all marketplaces and if the total file size of 
your ebook is too large (greater than 500KB) we may need to resave it to reduce size.

•	 Image pixel density greater than 300 DPI. 300 DPI is great quality for print, and overkill for 
ebooks. 72 DPI generally is fine.

•	 Image resolution greater than 3.2 million pixels (ex 1550x2050).

original image image cropped by the container
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Creating Cover Art
Don’t forget to add a cover image. You can’t create an ebook without a cover. You can insert cover 
art by pressing the Covers button. 
Tip: Create different covers for the ebook and print version.
Tip: For expert help creating cover art our Dream Team can help.

Upload for conversion

Steps for uploading and creating a reflowable ebook

1.	 Click on the ‘Upload’ icon  at the top right corner of the BookWright window.
2.	 Type in your book title, subtitle, and author name.
3.	 Review important warning messages.
4.	 Select the ‘Reflowable’ option under ‘Digital Book Versions’.
5.	 Choose a companion print option if desired.

6.	 Your BookWright file will be uploaded and converted. A progress dialog will show that the 		
conversion is underway.

       Tip: Depending on how large your book is this may take a few minutes.
7.	 When the conversion is completed successfully a browser window will open with information
       on what to do next.

Blurb BookWright Upload Options

Upload success screen
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Download and review your ebook

It’s time to congratulate yourself on all the hard work you’ve done so far: writing and editing your 
manuscript, getting your content into BookWright, formatting your layout, adding images, and 
styling your content. Nice job! But you’re not finished just yet.

After you’ve uploaded your project in BookWright we’ll create your ebook and send you an email 
with links to your ebooks viewable on Apple iPad and Amazon Kindle (EPUB3 and KF8 file formats, 
respectively). You’ll want to download it and take a look at your ebook on as many screens as you 
can, so that you can see what your readers will eventually see on various devices. As you review, you 
may find opportunities to make tweaks and changes that will help you provide a quality experience 
to more people. This section talks about how to get your content onto your devices for review. 
You can browse through previous sections in this guide for advice on how to make changes in 
BookWright to get your content looking perfect. On the upload success web page, and your Blurb 
dashboard, there’ll be a button to download your book. You’ll want to download it and take a look 
at your ebook on as many screens as you can, so that you can see what your readers will eventually 
see on various devices. As you review, you may find opportunities to make tweaks and changes that 
will help you provide a quality experience to more people. This section talks about how to get your 
content onto your devices for review. You can browse through previous sections in this guide for 
advice on how to make changes in BookWright to get your content looking perfect.

How to view your downloaded KF8 (.mobi) file:
Amazon provides a number of ways to preview your ebook file. You can view the ebook on your 
Kindle device or on your desktop through a free Kindle Reading App.
For instructions how to email a file to your Kindle e-Ink or Fire device click here.

How to view your downloaded EPUB3 (.epub) file on an iPad or desktop
1.	 If you do not have the free Apple iBooks app you’ll need to install it on your iPad before 

downloading your book. 
2.	 Tap on the download link in your email app.
3.	 Safari will open and begin downloading the ebook to your device.
4.	 When the download is complete, you will be given the option to ‘Open in iBooks.’ Tap this button 

once.
5.	 iBooks will launch, import the ebook, and then open it for viewing.

A few notes for a 
smoother experience 
when viewing on an iPad...

•	 Connect to wi-fi: 
ebooks can be large, 
so downloading and 
importing them to 
iBooks can take several 
minutes.

•	 Be patient: Very little 
feedback is given while 
iBooks is opening the 
file, so you may want to 
check your device after 
a few minutes.

•	 Make room: Be sure you 
have enough free space 
on your device or the 
download may fail.

•	 Can’t find your book? 
In iBooks, make sure 
you’re viewing the 
‘Books’ collection and 
not the ‘PDFs’ collection. 
To switch views, just tap 
the ‘Collections’ button 
in your iBooks library.

You can also view your books 
in iBooks for OSX Mavericks, 
or in Readium, a free EPUB3 
reader plug-in for Chrome.

https://www.amazon.com/gp/digital/fiona/kcp-landing-page?ie=UTF8
http://www.amazon.com/gp/help/customer/display.html?nodeId=200140600
https://itunes.apple.com/us/app/ibooks/id364709193?mt=8
https://chrome.google.com/webstore/detail/readium/fepbnnnkkadjhjahcafoaglimekefifl?hl=en-US
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Selling and distributing on marketplaces

Once your ebook is ready for sale, you have a number of options where to sell it. At the moment Blurb 
does not directly distribute reflowable ebooks on third-party marketplaces (such as the Kindle Store 
or the Apple iBooks Store). However, once the ebook files you’ve created are ready you can sell them 
independently wherever you’d like.

Selling your reflowable ebook on the Apple iBooks Store
Your ebook, in industry-standard EPUB3 (.epub) format, can be sold on the Apple iBooks Store. This 
process is handled through Apple, but here’s what you need to do:

1.	 Download your ebook from your dashboard on Blurb. Enter your email address and you’ll receive an 
email the link to get your ebook onto your computer.

2.	 Sign up for an iBooks Store seller’s account. Apple will ask you for your tax information and you will 
need to set up a payment method.

3.	 Use iTunes Producer to upload your ebook.
4.	 Fill out the forms. You’ll need to fill out information for your book, verify you hold the publishing rights, 

upload your ebook file and a cover image, and set pricing for every territory in which you are selling 
the book.

5.	 Save and publish.

Apple reports that it’ll take 24 hours to review and publish your ebook.

Selling your reflowable ebook with Kindle Direct Publishing
Your ebook, in Kindle-friendly KF8 (.mobi) format, can also be sold on Amazon.com through Kindle Direct 
Publishing (KDP). This process is all done through Amazon.com, but here’s what you need to do:
 
1.	 Download your ebook from your dashboard on Blurb. Enter your email address and you’ll receive an 

email the link to get your ebook onto your computer.
2.	 Sign up for a KDP account. Amazon will ask you for your tax information and you will need to set up a 

payment method.
3.	 Add your title to Amazon. Go to your “Bookshelf” page on the KDP site and click “Add new title,” then 

accept the terms and conditions—if this is your first Kindle book.
4.	 Fill out the forms. You’ll need to fill out information for your book, verify you hold the publishing rights, 

upload your ebook file and a cover image, and set pricing for every territory in which you are selling 
the book.

5.	 Save and publish. Life is full of check boxes—check one more and you’re on your way.

Amazon reports that it takes about 12 hours for your book to be available for purchase. Additionally, 
Amazon will usually be able to link your print book and ebook, provided the content, title, and contributors 
are identical.

https://www.apple.com/itunes/working-itunes/sell-content/books/
https://kdp.amazon.com/
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Conclusion

Pat yourself on the back because you’ve made it to the end of this guide. Hopefully you’ve learned 
enough about BookWright and how our ebook conversion process works that you’re in the rhythm of 
editing, uploading, proofing and making revisions to get your ebook perfect. 

•	 If you’re stuck and something doesn’t look the way you expected here again are some places to 
get help.

•	 If the structure or order of your chapters is off, take a look at the Book Structure and 
Organization section of this guide.

•	 For layout and text questions, review the Content Layout and Text Styling and Images section of 
this guide.

•	 For a quick start on common tasks, watch some of our helpful videos on using BookWright.
•	 Want to hire a publishing expert? Speak with a pro from our Dream Team.
•	 Read our FAQ. Someone has probably asked a similar question to yours.
•	 Contact our 24/7 customer support team – blurb.com/help

https://www.youtube.com/playlist?list=PLPeS5XD2B_Yxpu6-ZgxpFDVgyNDPR51JQ
http://www.blurb.com/dreamteam/collaborators
https://support.blurb.com/entries/60413840
https://support.blurb.com/home

